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Copyright
Copyright © 2007 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Li-Ion batteries, discharge the battery from time to time by leaving the product
switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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 Product selection
RM-313 is a WCDMA/GSM dual mode handportable phone, supporting EGSM850/900/1800/1900 and
WCDMA2100.

RM-313 is a 3GPP Release 5 terminal supporting WCDMA/HSDPA, EGPRS and GPRS data bearers. For WCDMA
HSDPA the maximum bit rate is up to 3.6 Mbps for downlink and 384 kbps for uplink with simultaneous CS
speech or CS video (max. 64 kbps).

For 2G and 2.5G networks the RM-313 is a Class A EGPRS DTM MSC 11 which means maximum download speed
of up to 236.8 kbps simultaneously with speech or Class B EGPRS MSC 32 which means a in maximum download
speed of up to 296kbit/s with EGPRS, and up to 107kbit/s with GPRS.

According to GSM standard 05.05 it responds to class 4 (max. 2W) in GSM 850 and EGSM 900 class 1 (1W) in
DCS 1800 and class 1 in PCS 1900. RM-313 supports EGPRS (EDGE) class B as well as Bluetooth 2.0 EDR standard.

RM-313 supports two way video calls with two integrated cameras, one on the front and one on the back.

RM-313 is an MMS (Multimedia Messaging Service) enabled multimedia computer with a 2.4’’ QVGA (240 x
320 pixels) TFT colour display and an integrated 5 Megapixel auto focus camera. The MMS implementation
follows the OMA MMS standard release 1.2. The Browser is a highly advanced internet browser also capable
of viewing operator domain XHTML Mobile Profile (MP) content.

RM-313 uses Symbian 9.2 operating system and supports also MIDP Java 2.0 & CLDC1.1, providing a good
platform for compelling 3rd party applications.

Figure 1 View of RM-313

 Product features and sales package

Imaging
Main camera:
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• Sensor: CMOS, 5 megapixel

• Carl Zeiss Optics: Tessar™ lens

• F number/Aperture: F2.8

• Focal length: 5.6 mm

35 mm (35 mm equiv.)

• Focus range: 10 cm ~ infinity

• Macro focus distance: 10-50 cm

• Shutter speed: Mechanical shutter 1/1000~1/4 s

• Lens protection: Sliding cover with activation

Video:

• Video resolution: up to VGA at 30 fps

• Audio recording: AAC (AMR for MMS)

• Video stabilization

• Video clip length: 59 min 59 sec

• Video file format: .mp4 (default) , .3gp (for MMS)

• White balance: automatic, sunny, cloudy, incandescent, fluorescent

• Scene: Auto, Night

• Colour tone: normal, sepia, B&W, vivid, negative

• Zoom (optical/digital): 1x / up to 10x (VGA 4X)

Photo:

• Still image resolutions: up to 5 megapixel: 2592 x 1944

• Still image file format: JPEG/EXIF

• Auto focus

• Auto exposure: center weighted AE

• Image orientation: automatic

• Exposure compensation: +2 ~ -2EV at 0.5 step

• White balance: automatic, sunny, cloudy, incandescent, fluorescent

• Scene: auto, sports, portrait, close-up, landscape, night, user defined

• Colour tone: normal, sepia, B&W, vivid, negative

• Zoom (digital): up to 20x (5Mpix 6X)

Other camera features:

• Xenon flash and recording indicator

• Front camera, CIF (352 x 288) sensor

Edit
• On device Photo editor and Video editor (manual & automatic)

View
• 2.4” QVGA (240 x 320 pixels) TFT colour display, ambient light detector - used to optimize display and

keypad backlight brightness and power consumption

• Slideshow from Gallery

RM-313
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Share
• Nokia XpressShare - share effortlessly from Gallery or after capture via Email, Bluetooth or MMS

• Direct connection to TV via cable or WLAN (UPnP)

• Video call and video sharing support. (WCDMA services)

• Online Album : Image/Video uploading from Gallery

Print
• Nokia XpressPrint – direct printing via USB (PictBridge), Bluetooth (BPP), and WLAN (UPnP), from memory

card or via online printing

Store
• Nokia XpressTransfer – easy to transfer and organize photos and video between your device and a

compatible PC

• Photoshop Album 3.0 Starter Edition (PC)

• Nokia Lifeblog (mobile & PC)

Music
• Digital music player: supports MP3/AAC/M4A/WMA with playlists

• Dedicated music keys

• OMA DRM 2.0 & WMDRM support for music

• Stereo FM radio (87.5-108MHz)

• Integrated stereo handsfree speakers

• Music headset HS-44 & music remote AD-43

Media
• Mobile TV experience with video streaming

• Full web browser support (HTML)

• Visual Radio™ support

Productivity
Messaging:

• E-mail (SMTP, IMAP4, POP3), MMS, SMS

Office applications:

• Viewing of email attachments – .doc, .xls, .ppt, . pdf

PIM:

• Contacts, calendar, to-do, notes, recorder, calculator, clock, converter

Synchronization:

• Local/Remote (using SyncML)

• Data: Calendar, Contacts, To-do, Notes, E-mail

• PC Applications: Microsoft Outlook (98, 2000, 2002, 2003), Outlook Express, Lotus Organizer (5.0, 6.0),
Lotus Notes (5.0, 6.0)

Call management:

• Call logs, speed dial, voice dialling (with SIND) and voice commands

RM-313
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• Nokia Push to Talk (PoC)

Connectivity
• WLAN - IEEE802.11 g/b with UPnP support

• Micro USB type B interface with USB 2.0 full speed

• 3.5mm stereo headphone plug and TV out support (PAL/NTSC)

• Bluetooth wireless technology 2.0 with A2DP stereo audio

Add-on software framework
• Symbian 9.2 OS

• Nokia Series 60, 3rd edition, feature pack 3.1

• Java: MIDP2.0

• C++ and Java SDKs

Additional technical specifications
• Vibrating alert

• 3GPP Rel 5 compliant

• Speech codecs supported in WCDMA: AMR

• Speech codecs supported in GSM: FR AMR/HR AMR/EFR/FR/HR

• WCDMA HSDPA 2100 MHz with simultaneous voice and packet data (PS max speed DL/UL= 3.6Mbps/
384kbps, CS max speed 64kbps)

• Dual Transfer Mode (DTM) support for simultaneous voice and packet data connection in GSM/EDGE
networks. Simple class A, multi slot class 11, max speed DL/UL: 118.4/118.4kbits/s

• EGPRS class B, multi slot class 32, (5 Rx + 3 Tx / Max Sum 6), max speed DL/UL= 296 / 177.6 kbits/s

• GPRS class B, multi slot class 32 (5 Rx + 3 Tx / Max Sum 6), max speed DL/UL= 107 / 64.2 kbits/s

• GPS

Sales package
• Transceiver RM-313

• Charger (AC-5)

• Battery (BP-6MT)

• Music headset (HS-43)

• Connectivity cable (CA-101)

• Video out cable (CA-75U)

• MicroSD card (MU-37)

 Mobile enhancements

Table 1 Audio

Enhancement Type

Music headset HS-44 with AD-43 3.5mm stereo plug, HS-45 with
AD-54 3.5mm stereo plug

Basic headset HS-41

Stereo headset HS-48, HS-16, HS-43

RM-313
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Enhancement Type

Bluetooth headset BH-900, BH-902 & BH-903

BH-800

STEREO BH-501

BH-601

MONO BH-200, BH-201

BH-202

BH-303

BH-300

BH-702

BH-500

BH-600, BH-602 & BH-604

BH-101

BH-803

Wireless stereo gateway AD-42W

Music headphone HS-61

Advanced headphone HS-62

Music speaker MD-3

Mini speaker MD-4, MD-6

Audio Adapter AD-53, AD-63

BT speakers MD-5W, MD-7W

FM transmitters CA-300

Table 2 Car

Enhancement Type

Mobile charger DC-4

Wireless plug-in car handsfree HF-500

HF-33W

HF-300

Car kit Nokia 616, 810

Multimedia car kit CK-20W, CK-7W & CK-15W

Table 3 Data

Enhancement Type

Connectivity cable CA-101

RM-313
General Information

Issue 1 COMPANY CONFIDENTIAL Page 1 –9
Copyright © 2007 Nokia. All rights reserved.



Enhancement Type

Video connectivity cable CA-75U

MicroSD card 128MB - 2GB

Table 4 GPS

Enhancement Type

Wireless GPS module LD-3W

Navigation pack LD-2

Table 5 Messaging

Enhancement Type

Digital pen SU-27W

Wireless keyboard SU-8W

Table 6 Power

Enhancement Type

Battery 1050mAh Li-ion BP-6MT

Travel charger AC-5

AC-6, CA-100

Charger adapter CA-44

Table 7 Carrying

Enhancement Type

Carrying case

 Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T)
(mm)

Weight (g) Volume (cm3)

Transceiver with
BP-6MT 1050mAh li-ion
battery back

112 x 50.2 x 17.3 ~ 120

RM-313
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Main RF characteristics for GSM850/900/1800/1900 and WCDMA 2100 phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, WCDMA 2100

Rx frequency band GSM850: 869 - 894MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA2100: 2110 - 2170 MHz

Tx frequency band GSM850: 824 - 849MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA2100: 1920 - 1980 MHz

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA -50 … 24 dBm

Number of RF channels GSM850: 124

GSM900: 174

GSM1800: 374

GSM1900: 299

Number of WCDMA channels WCDMA: 277

Channel spacing 200 kHz

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

Battery endurance

Battery Capacity (mAh) Talk time Stand-by

BP-6MT 1050 up to 180 min (WCDMA

up to 250 min (GSM)

up to 215 h (WCDMA)

up to 230 h (GSM)

RM-313
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Charging times

AC-6

1h 30 min

Environmental conditions

Environmental
condition

Ambient temperature Notes

Normal operation -15 oC ... +55 oC Specifications fulfilled

Reduced performance 55 oC ... +70 oC Operational only for short periods

Intermittent or no
operation

-40 oC ... -15 oC and +70 oC ... +85oC Operation not guaranteed but an
attempt to operate will not damage
the phone

No operation or
storage

<-40 oC and >+85 oC No storage. An attempt to operate
may cause permanent damage

Charging allowed -15 oC ... +55 oC

Long term storage
conditions

0 oC ... +85 oC

Humidity and water
resistance

Relative humidity range is 5 to 95%.

Condensed or dripping water may
cause intermittent malfunctions.

Protection against dripping water
has to be implemented in (enclosure)
mechanics.

Continuous dampness will cause
permanent damage to the module.
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 New tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-313, refer to various concepts.

FS-65 Flash adapter

FS-65 has the following features:

• Provides galvanic connection to terminal test pads

• Provides standardized interface towards Control Unit

• Provides RF connection using galvanic connector or coupler

MJ-151 Module jig

MJ-151 is meant for troubleshooting, testing, tuning and flashing on
the engine level (CU-4 supported).

The jig includes an RF interface for GSM, WCDMA and Bluetooth.

RJ-189 Soldering jig

The jig is used for soldering and as a rework jig for the system module.
It is made of lead-free rework compatible material.

SA-106 RF coupler

SA-106 is an RF coupler for WCDMA and GSM RF testing. It is used
together with the product-specific flash adapter.

 Reused tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-313, refer to various concepts.
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CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.

CA-31D USB cable

The CA-31D USB cable is used to connect FPS-10 or FPS-11 to a PC. It is
included in the FPS-10 and FPS-11 sales packages.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.

RM-313
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable

Note: FPS-21 is substitute FPS-10 if FPS-10 has not been set
up.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.

PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.
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RJ-105 Rework jig

RJ-105 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-38 stencil.

RJ-157 Rework jig

RJ-157 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-55 stencil.

RJ-160 Rework jig

RJ-160 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-55 stencil.
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RJ-166 Rework jig

RJ-166 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-53 stencil.

RJ-169 Rework jig

RJ-169 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-59 stencil.

RJ-93 Rework jig

RJ-93 is a rework jig used with ST-40.

SA-131 RF coupler

SA-131 is a generic device for GPS testing. It is used together with
SS-62.
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SB-6 Bluetooth tester

The SB-6 test box is a generic device to perform Bluetooth bit error
rate testing and doing cordless FBUS connection via Bluetooth.

SB-7 WLAN test box

WLAN test requires defined position for the device.

SPS-2 Soldering paste
spreader

SRT-6 Opening tool

SRT-6 is used to open phone covers.
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SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB

SS-93 Opening tool

SS-93 is used for opening JAE connectors.

ST-38 Rework stencil

ST-38 is a rework stencil used with rework jig RJ-105.

ST-40 Rework stencil

ST-40 is a rework stencil and used with RJ-93.
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ST-53 Rework stencil

ST-53 is a rework stencil used with rework jig RJ-166.

ST-55 Rework stencil

ST-55 is a rework stencil used with rework jig RJ-157 and RJ-160.

ST-59 Rework stencil

ST-59 is a rework stencil used with rework jig RJ-169.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.
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XCS-1 Service cable

The XCS-1 service cable is used to connect FLS-4S to the POS flash
adapter for supplying a controlled operating voltage and data
connection.

XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRS-6 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector approximately 610 mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB
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 Service concepts

POS (Point of Sale) flash concept

Figure 2 POS flash concept

Type Description

Product specific tools

BP-6MT Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software

Cables

CA-101 USB connectivity cable
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Flash concept with FPS-10

Figure 3 Basic flash concept with FPS-10

Type Description

Product specific devices

FS-65 Flash adapter

Other devices

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

XCS-4 Modular cable

CA-35S Power cable

USB cable
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CU-4 flash concept with FPS-10

Figure 4 CU-4 flash concept with FPS-10

Type Description

Product specific devices

FS-65 Flash adapter

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

PCS-1 Power cable

XCS-4 Modular cable

Standard USB cable

USB cable
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Flash concept with FPS-10 and JBT-9

Figure 5 Flash concept with FPS-10 and JBT-9

Type Description

Product specific tools

FS-65 Flash adapter

Other tools

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-46 Interface adapter

JBT-9 Bluetooth test and interface box

PC with Phoenix service software

Cables

XCS-4 Modular cable

CA-35S Power cable

USB cable
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Flash concept with SS-46 and CA-89DS

Figure 6 Flash concept with SS-46 and CA-89DS

Type Description

Product specific tools

FS-65 Flash adapter

Other tools

FLS-5 Flash device

SS-46 Interface adapter

PC with Phoenix service software

Cables

CA-89DS Cable
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Flash concept with CA-89DS

Figure 7 Flash concept with CA-89DS

Type Description

Product specific tools

FS-65 Flash adapter

Other tools

FLS-5 Flash device

PC with Phoenix service software

Cables

CA-89DS Cable
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Flash concept with SS-62 and CA-89DS

Figure 8 Flash concept with SS-62 and CA-89DS

Type Description

Product specific tools

FS-65 Flash adapter

Other tools

CU-4 Control unit

FLS-5 Flash device

SS-62 Flash adapter base

PC with Phoenix service software

Cables

CA-89DS Cable

PCS-1 Power cable

USB cable
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Flash concept with FPS-10, SS-62 and JBT-9

Figure 9 Flash concept with FPS-10, SS-62 and JBT-9

Type Description

Product specific tools

FS-65 Flash adapter

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

JBT-9 Bluetooth test and interface box

SX-4 Smart card

PC with Phoenix service software

Cables

XCS-4 Modular cable

PCS-1 Power cable

USB cable
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Flash concept with FPS-10, SS-62 and SB-7

Figure 10 Flash concept with FPS-10, SB-7 and JBT-9

Type Description

Product specific tools

FS-65 Flash adapter

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SB-7 WLAN test box

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

XCS-4 Modular cable

PCS-1 Power cable

USB cable
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Module jig service concept

Figure 11 Module jig service concept

Type Description

Phone specific devices

MJ-151 Module jig

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PK-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

PCS-1 DC power cable

XCS-4 Modular cable

XRF-1 RF cable

USB cable
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Type Description

GPIB control cable

Module jig service concept with JBT-9 and smart card reader

Figure 12 Service concept with JBT-9 and smart card reader

Type Description

Product specific tools

MJ-151 Module jig

Other tools

CU-4 Control unit

JBT-9 Bluetooth test and interface box

PKD-1/PK-1 SW security device

SX-4 Smart card

Measurement equipment

PC with Phoenix service software

Smart card reader

Cables

DAU-9S MBUS cable

PCS-1 DC power cable

XRS-6 RF cable

GPIB control cable
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Type Description

USB cable

Module jig service concept with JBT-9

Figure 13 Module jig service concept with JBT-9

Type Description

Product specific tools

MJ-151 Module jig

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

JBT-9 Bluetooth test and interface box

PKD-1 SW security device

SX-4 Smart card

Measurement equipment

PC with Phoenix service software

Cables

PCS-1 DC power cable

XCS-4 Modular cable

XRS-6 RF cable
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Type Description

GPIB control cable

USB cable

RF testing concept with RF coupler

Figure 14 RF testing concept with RF coupler

Type Description

Product specific devices

FS-65 Flash adapter

SA-106 RF coupler

Other devices

CU-4 Control unit

SX-4 Smart card

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

Measurement equipment

PC with Phoenix service software

Cables
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Type Description

PCS-1 Power cable

XCS-4 Modular cable

XRS-6 RF cable

GPIB control cable

USB cable

Service concept for RF testing and RF/BB tuning

Figure 15 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

MJ-151 Module jig

Other devices

CU-4 Control unit

PK-1 SW security device

SX-4 Smart card

Measurement equipment

Smart card reader
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Type Description

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable

XRS-6 RF cable

GPIB control cable

USB cable
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 Dead or jammed device troubleshooting

Troubleshooting flow
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 General power checking troubleshooting - CMT

Troubleshooting flow

RM-313
BB Troubleshooting and Tuning Guide

Page 3 –6 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



 General power checking troubleshooting - APE

Troubleshooting flow
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 Clocking troubleshooting

Troubleshooting flow
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 Application processor troubleshooting

Troubleshooting flow
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 Charging troubleshooting

Troubleshooting flow
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 Battery current measuring fault troubleshooting

Troubleshooting flow
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 Flash programming fault troubleshooting

Troubleshooting flow
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Figure 16 Flashing pic 1. Take single triggered measurement for the rise of the BSI signal

Figure 17 Flashing pic 2. Take single triggered measurement for the rise of the BSI signal

RM-313
BB Troubleshooting and Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 –15
Copyright © 2007 Nokia. All rights reserved.



 CMT combo memory fault troubleshooting

Troubleshooting flow
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 Application processor memory troubleshooting

Troubleshooting flow
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 APE temperature sensor troubleshooting

Troubleshooting flow
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 TV-out troubleshooting

Troubleshooting flow
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 USB interface troubleshooting

Troubleshooting flow
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 SIM card troubleshooting

Troubleshooting flow
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 Memory card troubleshooting

Troubleshooting flow
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 WLAN interface troubleshooting

Troubleshooting flow
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 Camera MR sensor troubleshooting

Troubleshooting flow
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 Certificate restoring for BB5 products

Context
This procedure is performed when the device flash content is changed or corrupted.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FLS-5 or FPS-10.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: The request won't be accepted without a SX-4 smart card. Before the request, the smart card
must be registered in the online database.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• LatestPhoenix service software.

• The latest phone model specific Phoenix data package.

• PKD-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

• External smart card reader

Note: The smart card reader is only needed when FLS-5 is used. FPS-10 has an integrated smart card
reader.

• Activated FLS-5 flash device OR FPS-10 flash prommer

• The latest flash update package for FLS-5 flash device or FPS-10 flash prommer

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FLS-5 or FPS-10.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→Firmware Update  and wait until Phoenix reads the product data as shown in the
following picture.

Product is automatically set according to the phone support module which was opened manually,
but the flash files cannot be found because the correct data cannot be read from the phone
automatically.

Code must be chosen manually, it determines the correct flash files to be used. Please choose the
correct product code (can be seen in the phone type label) from the dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the SW Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .

iii To choose a location for the request file, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .

RM-313
BB Troubleshooting and Tuning Guide

Page 3 –28 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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 Keys troubleshooting

Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

1 One or more keys are stuck, so that the key(s) does not react when you press a keydome. This kind of
failure is caused by mechanical reasons (dirt, corrosion).

2 Malfunction of several keys at the same time; this happens when one or more rows or columns are failing
(shortcut or open connection). For a more detailed description of the keyboard and keymatrix, see section
Keyboard.

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Troubleshooting flow
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Power key troubleshooting

Troubleshooting flow
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NaviWheel troubleshooting

Troubleshooting flow
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 GPS troubleshooting

GPS layout and basic test points

Figure 18 GPS layout and basic test points

VBat, ASIC internal LDO voltages, and clocks are available as shown in figure above. In addition to these, the
following GPS signals are available on the test points:

• GPS_En_Reset – J6201

• U2Tx – J6202 (Activity on this pin indicates the GPS is operating.)

• IO_INT_U1CLK – J6203

• IO_TIMESTAMP_DATRDY – J6204

• SleepX – J2219

• Sleep Clk (RTC) – J2217

GPS settings for Phoenix

GPS control

Context
Use the following to test GPS using Phoenix.

Steps
1. Start Phoenix service software.

2. From the File menu, select Scan Product and check that the correct product version is displayed.
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3. From the Testing menu, select GPS Control. This opens up GPS Control dialogue box, as shown in the
figure below, and enables the GPS.

Figure 19 GPS Control dialog box

Select Idle to confirm the GPS is enabled and is in idle mode; at this point all clocks should be present,
GPS_En_Reset & SleepX should be high, and Vdd_Dig, Vcc_TCXO & Vcc_PLL/VCO will be present.

Receiver On turns on all RF sections of the ASIC and so all LDOs will be on. These checks are part of GPS
Basic Checks Troubleshooting Flow (page 3–39).

Quick Test window
The Quick Test window has all the necessary functionality for GPS troubleshooting. Ensure the test setup is
correct and click Start Test. (Select Help for further information).

This test will perform 3 tests in one; Self Test, Oscillator Test and CW Test, and will provide a Pass/Fail response.
It also contains a Receiver On button. These checks are part of GPS failure troubleshooting (page 3–37).
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Figure 20 GPS Quick Test window for GPS troubleshooting

GPS RF test points
The GPS antenna test pads are located on the top side under the keymat as shown in figure "GPS antenna
test pads". Checking for a connection between these two test points will confirm that the antenna is working
correctly, as well as performing a radiated CW test.

J6212 = GPS Ant

J6213 = GPS Ant Gnd

In order to probe GPS RF test points, inject 1575.52 MHz tone @ -50dBm at the GPS antenna test connector
and select Receiver On, then probe the GPS RF test points as shown in figure "GPS RF probe points". Compare
RF levels with a known reference phone.
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Figure 21 GPS antenna test pads

Figure 22 GPS RF probe points

GPS failure troubleshooting flow

Context
GPS troubleshooting is broken down into two parts: general GPS failure & GPS basic checks. The GPS failure
troubleshooting flow can be followed and, where applicable, will feed into the Basic checks troubleshooting
flow.
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Troubleshooting flow
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GPS basic checks troubleshooting flow

Troubleshooting flow
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 Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• Display is in a partial idle mode when the phone is in the screen saver mode.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 8 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the
connector or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 9 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.
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Steps
1. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

2. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

3. Proceed to the display troubleshooting flowcharts.

Use the Display Test tool in Phoenix to find the detailed fault mode.
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Display troubleshooting

Troubleshooting flow
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Display and keyboard backlight troubleshooting

Context
The device has one LED driver that provides current for both display and keyboard backlights and another
LED driver that provides current for ITU and side key backlights.

Keyboard backlights are turned ON only in dark conditions. This is controlled by the Ambient Light Sensor
(ALS). Also the brightness of the display is adjusted by the ambient light sensor.

You can enable/disable ALS with the help of Phoenix service software.

Display brightness can be adjusted manually, if ALS is disabled. If the ambient light sensor is enabled, it
adjusts the display brightness automatically.
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Troubleshooting flow
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Backlight troubleshooting

Troubleshooting flow
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SMPS LED driver troubleshooting

Troubleshooting flow
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Current pump LED driver troubleshooting

Troubleshooting flow

Ambient Light Sensor (ALS) troubleshooting

Context
• If ALS (Poliwag) is broken, replace it.

• After replacing the ALS, ALS re-tuning is required for example if calibration values of the new sensor are
lost (see instructions later in this document).

• When carrying out the ALS calibration procedure, it is required to have a reference phone, which includes
calibrated ALS. ALS re-tuning instructions below explain why the reference phone is needed.

• Make sure that you have completed Display and keypad backlight troubleshooting (page ) first before
starting ALS troubleshooting.

Here are some hints for ALS troubleshooting:

• In Phoenix Display Test tool, there is anAmbient Light Sensor window, which shows the luminance. The
correct luminance in darkness is <20 lx, and in office environment 100-2000 lx. The luminance value
depends strongly on the light source and the angle of the phone, so these values are only a rough guideline.

• LED drivers’ control voltage measurement points can be found in the SMPS LED drivers troubleshooting
(page 3–46) and Current pump LED driver troubleshooting (page 3–47) sections. When backlight brightness
is set to 100%, the PWM signal is continuously on high state.
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• Phoenix has an ambient light sensor calibration tool for changing calibration values. Concerning Poliwag
ALS, there is no need for performing a pull-up resistor calibration (as for earlier Ambient Light Sensors).

Re-tune Poliwag ALS as follows:

Steps
1. Connect the reference phone to Phoenix and set the phone (e.g. on the table) so that the amount of

ambient light is as stabile as possible seen by Poliwag ALS. Light guide of the ALS is located in the upper
part of the phone’s A-Cover.

2. Start Phoenix.

3. Choose File→Scan Product.

4. Choose Testing→Display Test.

You should see the following window:

Figure 23 Ambient Light Sensor Calibration window

Open the Lights tab, check the Ambient Light Sensor check box, Click Read to get reference ambient
light value from the Luminance text box and write it down.

5. Repeat steps 1 to 4 to calibrate the phone and make sure the phone to be calibrated is located in the same
place as the reference phone was when luminance reading was taken. Write down the illuminance of the
phone to be calibrated.

6. Calculate the co-efficient from the reference and the phone to be calibrated luminance values by division:
Co-efficient = luminance (reference phone) / luminance (phone to be calibrated), write down the
calculated co-efficient value.

7. Choose Tuning→Ambient Light Sensor Calibration .

You should see the following window:
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Iterate by changing IPhoto (reference level) value (remove cross from Use manually added values).
After writing a value to IPhoto (reference value), press the Calibrate button. Stop iterating when the co-
efficient is equal to the co-efficient calculated in bullet 6. Note that decimal numbers should be used in
the iteration in order to achieve enough precision (e.g 23.2455).

8. After having a co-efficient value in the Co-efficient textbox as the calculated value, make sure that
ambient light values (read using TestingDisplay TestLuminance textbox) are almost the same in the
reference phone and the calibrated phone. Remember that illuminance readings for the reference and
calibrated phones must be done in the same ambient light conditions. If illuminance values differ a lot
(difference max. +- 10%), repeat the ALS re-tuning procedure from the beginning.

9. To end the calibration, click Close.

Backlights controlling in Phoenix
There are two power sources for lights. One is an SMPS type LED driver giving about 16V out, when 4 LEDs
are connected as serial between its output and GND. Output is shared to two branches (4 + 4 LEDs in serial).
This SMPS type LED driver is used for powering the display and S60 keyboard lights. Display lights must be
switched ON before it is possible to switch ON S60 keybord lights. However, S60 keyboard lights can be
switched OFF, although display lights are still ON.

The second LED driver (a current pump type driver) is used for powering all other LEDs (ITU keyboard and
side keys lights). This driver includes seven outputs. Each LED is connected straight from driver output to
GND. Different keybord lighting groups can be switched ON/OFF separately. In addition to that, it is possible
to switch ON/OFF every side key light independently.

Switching display lighting on using Phoenix

Steps
1. Connect phone to Phoenix.

2. Start Phoenix.

3. Choose File Scan Product.

4. Choose Display Display test.

RM-313
BB Troubleshooting and Tuning Guide

Issue 1 COMPANY CONFIDENTIAL Page 3 –49
Copyright © 2007 Nokia. All rights reserved.



5. Click the Lights sheet.

6. From Target partition, select Display.

7. From State partition, select On.

8. Set Level to 100 and click Write.

9. Click Close to end the lights testing.

Note: It is possible to set any value between 0…100 for display lights.

Switching display lighting OFF using Phoenix

Prerequisites
First, go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49), if not done yet

Steps
1. From Target partition, select Display.

2. From State partition, select Off.

3. Set Level to 0 and click Write.

4. Click Close to end the lights testing.

Switching S60 keyboard lighting ON using Phoenix

Prerequisites
First, go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49), if not done yet.
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Note: It is not possible to switch S60 keyboard lighting ON if display lighting is not activated (all
other keyboard lights can be activated, although display lights would be OFF, but not S60 keyboard
lights).

Steps
1. From Target partition, select Keyboard.

2. From State partition, select On.

3. Set Level to 100 and click Write.

4. Click Close to end the lights testing.

Note: The S60 keyboard lighting brightness follows display lighting brightness value, i.e. it is not
possible to set different brightness for display and S60 keyboard lighting.

Switching S60 keyboard lighting OFF using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select Keyboard.

2. From State partition, select Off.

3. Set Level to 0 and click Write.
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4. Click Close to end the lights testing.

Switching ITU (numeric) keyboard lighting ON using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select Keyboard2.

2. From State partition, select On.

3. Set Level to 100 and click Write.

4. Click Close to end the lights testing.

Switching ITU (numeric) keyboard lighting OFF using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select Keyboard2.

2. From State partition, select Off.

3. Set Level to 0 and click Write.
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4. Click Close to end the lights testing.

Switching volume keys lighting ON using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select SIDELED1.

2. From State partition, select On.

3. Set Level to 100 and click Write.

4. Click Close to end the lights testing.

Switching volume keys lighting OFF using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select SIDELED1.

2. From State partition, select Off.

3. Set Level to 0 and click Write.
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4. Click Close to end the lights testing.

Switch imaging key lighting ON using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select SIDELED2.

2. From State partition, select On.

3. Set Level to 100 and click Write.

4. Click Close to end the lights testing.

Switching imaging key lighting OFF using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select SIDELED2.

2. From State partition, select Off.

3. Set Level to 0 and click Write.
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4. Click Close to end the lights testing.

Switching shutter key lighting ON using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select SIDELED3.

2. From State partition, select On.

3. Set Level to 100 and click Write.

4. Click Close to end the lights testing.

Switching shutter key lighting OFF using Phoenix

Prerequisites
First go through steps 1-5 in Switching display lighting ON using Phoenix (page 3–49) if not done yet.

Steps
1. From Target partition, select SIDELED3.

2. From State partition, select Off.

3. Set Level to 0 and click Write.
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4. Click Close to end the lights testing.

 Bluetooth and FM radio troubleshooting

Introduction to Bluetooth troubleshooting
There are two main Bluetooth problems that can occur:

Problem Description

Detachment of the BT antenna. This would most likely happen if the device has
been dropped repeatedly to the ground. It could
cause the BT antenna to become loose or partially
detached from the PWB (see the details of BT/WLAN
antenna).

A malfunction in the BT ASIC, BB ASICs or Phone’s BT
SMD components.

This is unpredictable and could have many causes
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the BT system or the
phone’s BB and then replace/fix the faulty component.

Figure 24 Bluetooth placement on the bottom side
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Figure 25 Bluetooth placement on the top side

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.

4. Choose Testing→Bluetooth LOCALS .

5. Locate JBT-9’s serial number (12 digits) found in the type label on the back of JBT-9.

In addition to JBT-9, also SB-6, JBT-3 and JBT-6 Bluetooth test boxes can be used.

6. In the Bluetooth LOCALS window, write the 12-digit serial number on the
Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.

7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in the Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window.
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Figure 26 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. ChooseFile→Scan Product.

3. Place the phone to a flash adapter.

4. From the Mode drop-down menu, set mode to Local.

5. Choose Testing→Self Tests.

6. In the Self Tests window check the following Bluetooth related tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST
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7. To run the tests, click Start.

Figure 27 Bluetooth self tests in Phoenix
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Bluetooth troubleshooting

Troubleshooting flow
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FM radio troubleshooting

Context

Figure 28 FM radio placement on the bottom side
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Figure 29 FM radio placement on the top side
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Troubleshooting flow

 Audio troubleshooting

Audio paths
The earpiece is driven directly by a built-in linear power amplifier included in the EM ASIC N2200 ASIC. The
output has a differential output configuration. Signal lines are biased by the EM ASIC N2200.

The vibra is driven directly by a built-in digital pulse modulated amplifier included in the EM ASIC N2200 ASIC.
The output has a differential output configuration.

Nokia AV stereo output is driven by a discrete stereo headphone amplifier that is connected to the single-
ended outputs of the EM ASIC N2200 ASIC (shared output with the discrete stereo speaker amplifier). The
discrete stereo headphone output has a single-ended ground reference output. It’s controlled gain change
via I2C IF.
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Stereo speakers are driven by a discrete digital stereo speaker amplifier that is connected to the single-ended
outputs of the EM ASIC N2200 (shared output with the discrete stereo headphone amplifier). The discrete
stereo speaker amplifier has a differential output configuration.

The internal microphone is connected directly to the single-ended input of the EM ASIC N2200. Signal line is
biased by the EM ASIC N2200.

Nokia AV mono input is connected to the EM ASIC N2200 single-ended input via two switches: data-switch
and video-switch. The input is biased by the EM ASIC N2200.

Audio loop test
Audio paths can be tested via a built-in audio loop test routine. To test a specific audio path, an electrical
test signal can be fed into the mono input of the Nokia AV-connector and looped to specified audio output:
earpiece, stereo speakers or the Nokia AV stereo output. Similarly, an acoustical or an electrical test signal
can be fed into the internal microphone and looped to the Nokia AV stereo output. Loop routines can be
initiated using the audio test interface in the Phoenix service program.

Vibra can be tested by dedicated vibra test in the Phoenix service program.

Table 10 Audio loop test reference results

Audio loop Input terminal Output terminal Frequency Input signal Output signal

XMIC to EAR AV connector Internal earpiece 1kHz 0.1 [V] y [V]

XMIC to IHF AV connector Stereo speakers 2kHz 0.1 [V] y [A]

XMIC to
XEAR AV connector AV connector 1kHz 0.1 [V] y [V]

INTMIC to
XEAR

Internal
microphone AV connector 1kHz 0.01 [V] y [V]
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow

RM-313
BB Troubleshooting and Tuning Guide

Page 3 –66 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



Stereo speakers troubleshooting

Troubleshooting flow
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AV stereo output troubleshooting

Troubleshooting flow
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AV mono input troubleshooting

Troubleshooting flow
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Vibra troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management Calibration.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 11 Calibration value limits

Parameter Min. Max.

ADC Gain 13000 13350

ADC Offset -14 14

BSI Gain 1100 1300

VBAT_SCAL Gain 21000 21900

VBAT_SCAL Offset 2450 2570

IBAT Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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4  — RF troubleshooting
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 General RF troubleshooting

Introduction to RF troubleshooting

Most RF semiconductors are static discharge sensitive
ESD protection must be applied during repair (ground straps and ESD soldering irons).

Pre-baking
These parts are moisture sensitive and must be pre-baked prior to soldering:

• RF IC N7505

• Front End Module (FEM) N7520

• WCDMA PA N7540

Discrete components
In addition to the key-components, there are a number of discrete components (resistors, inductors and
capacitors) for which troubleshooting is done mainly by visual inspection.

Capacitors: check for short circuits.

Resistors: check value with an ohm meter.

Note: In-circuit measurements should be evaluated carefully

Measuring equipment
All measurements should be done using:

• An oscilloscope for low frequency and DC measurements. Recommended probe: 10:1, 10Mohm//8pF.

• A radio communication tester including RF generator and spectrum analyser, for example Rohde & Schwarz
CMU200. (Alternatively a spectrum analyser and an RF generator can be used. Some tests in this guide are
not possible to perform if this solution is chosen).

Note: A mobile phone WCDMA transmitter should never be tested with full TX power (only it possible
to perform the measurements in a good RF-shielded room). Even low power WCDMA transmitters
may disturb nearby WCDMA networks and cause problems to 3G cellular phone communication in
a wide area.

Note: All measurements with an RF coupler should be performed in an RF-shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, testing at frequencies of nearby base stations should be avoided.
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RF key components

 Auto tuning for BB5.0
This phone can be tuned automatically.

Autotune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/XP) with GPIB card
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• Power supply

• Product specific module jig

• Cables: XRF-1 (RF cable), USB cable, GBIP cable and DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.

Figure 30 Auto tuning concept with CMU200

Note: Crossover Cable connection between computer and CU200 is recommended (refer to Service
Devices chapter and Module Jig concept).

Phoenix preparations
Install the phone specific data package, for example Nokia_firmware_RM-313_emea_nsu_10.0.005_v1.0.exe.
This defines phone specific settings..

Auto tuning procedure
1 Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.

2 To go to autotune, select Tuning (Alt-U) > Auto-Tune (Alt-A) from the menu.

3 Start autotuning, clicking the Tune button.

 General checkings

Antenna line component checking
Check R7560 (0ohm resistor).

Voltage checking

Steps
1. Set up the main board in the module jig. The phone should be in local mode.

2. Check the following:

# Signal name Test point Voltage (all bands)

1 VCTCXO supply R7501 2.5 V

2 AHNEUS supply from DC/DC conv L7502 3.2 V
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# Signal name Test point Voltage (all bands)

3 TXFBM supply C7523 3.9 V

4 WCDMA PA supply from DC/DC conv C7543 0 V (When transmitting 1.3 V - 3.1 V
depending on output power. *3.1 V
with settings as in the note below.)

5 Vbat at WCDMA PA L7550 3.9 V

6 Supply to AHNEUS DC/DC conv L7592 3.9 V

* With these settings, the result should be 3.1V.
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Figure 31 General voltage checking test points
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 Self test troubleshooting

Troubleshooting flow
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 Receiver troubleshooting

Introduction to receiver (RX) troubleshooting
RX can be tested by making a phone call or in local mode. For the local mode testing, use Phoenix service
software.

The main RX troubleshooting measurement is RSSI reading. This test measures the signal strength of the
received signal. For GSM RSSI measurements, see GSM RX chain activation for manual measurements / GSM
RSSI measurement (page 4–11). For a similar test in WCDMA mode, see WCDMA RX chain activation for
manual measurement / WCDMA RSSI measurement (page 4–12).

GSM RX chain activation for manual measurements/GSM RSSI measurement

Prerequisites
Make the following settings in Phoenix service software:

Setting GSM850 GSM900 GSM1800 GSM1900

Phoenix Channel 189 37 700 661

Signal generator
to antenna
connector

881.46771MHz
(67.71KHz offset)
at -60dBm

942.46771MHz
(67.71kHz offset)
at -60dBm

1842.86771MHz
(67.71kHz offset)
at -60dBm

1960.06771MHz
(67.71kHz offset)
at -60dBm

Steps
1. Set the phone to local mode.

2. Activate RSSI reading in Phoenix (Testing→GSM→RSSI reading )

Results
The reading should reflect the level of the signal generator (-losses) +/- 5 dB.

When varying the level in the range -30 to -102 dBm the reading should then follow within +/-5 dB.
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WCDMA RX chain activation for manual measurement/WCDMA RSSI measurement

Prerequisites
Make the following settings in Phoenix service software and in the signal generator.

Setting Band I

Phoenix channel 10700

Signal generator to antenna connector 2141.0 MHz

Signal generator RF-level (CW-signal) -70 dBm

Steps
1. Via Phoenix Testing menu, choose WCDMA/RX Control.

2. In the RX control window, make the following settings:

Figure 32 RX Control window with example settings

3. Click Start to activate the settings.

If the settings are changed later on (for example, change of channel) you have to click Stop and Start
again.

Note: Clicking Stop also disables TX control if it was active.

4. From the Phoenix testing menu, select WCDMA→RX Power measurement

5. In the RX Power measurement window, select:
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• Mode: RSSI

• Continuous mode

6. Click Start to perform the measurement.

Results
The reading should reflect the level of the signal generator (-losses) ± 5 dB.

 Transmitter troubleshooting

General instructions for transmitter (TX) troubleshooting
Please note the following before performing transmitter tests:

• TX troubleshooting requires TX operation.

• Do not transmit on frequencies that are in use!

• The transmitter can be controlled in local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is “RF Controls”; in WCDMA transmitter testing
the best tool is “TX Control”.

• Remember that re-tuning is not a fix! Phones are tuned correctly in production

Note: Never activate the GSM or WCDMA transmitter without a proper antenna load. Always connect
a 50 Ω load to the RF connector (antenna, RF-measurement equipment or at least a 2 W dummy
load); otherwise the GSM or WCDMA Power amplifier (PA) may be damaged.

GSM transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. Activate RF controls in Phoenix (Testing→GSM→Rf Controls ).

Make settings as shown in the picture:
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3. Check the basic TX parameters (i.e. power, phase error, modulation and switching spectrum), using a
communication analyser (for example CMU200).
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Figure 33 Typical readings

4. Change power level (RF controls) and make sure the power reading follows accordingly.
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Next actions
If you want to troubleshoot the other bands, change band with RF controls and set the communication
analyser accordingly.

GSM transmitter troubleshooting flowchart

Troubleshooting flow
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WCDMA transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select Testing→WCDMA→TX control .

3. In the TX control window, make settings like in the picture:

4. Click Send to enable the settings and activate TX.

If settings are changed (eg. new channel), you have to click RF Stop and Send again.
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WCDMA transmitter troubleshooting flowchart

Troubleshooting flow
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 Main (back) camera troubleshooting flowcharts

Main camera troubleshooting

Troubleshooting flow
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Main camera baseband troubleshooting

Troubleshooting flow
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Main camera baseband troubleshooting - powerings

Troubleshooting flow
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No recognizable viewfinder image

Troubleshooting flow
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Bad image quality troubleshooting

Troubleshooting flow
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Flash and LED troubleshooting

Context
Note: Before checking flash functionality, make sure that the main camera is working OK.

Troubleshooting flow
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 Secondary (front) camera troubleshooting flow

Troubleshooting flow
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 Accelerometer troubleshooting

Troubleshooting flow
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 Xenon flash troubleshooting

Introduction to camera module troubleshooting

Background, tools and terminology
Faults or complaints in camera operation can be roughly categorised into two subgroups:

1 Flash is not functional at all; no image can be taken.

2 Images can be taken and they are recognizable but for some reason the quality of images is seriously
degraded, or customer complains about image quality

Image quality is very hard to measure quantitatively, and even comparative measurements are difficult
(comparing two images) to do, if the difference is small. Especially if the user is not satisfied with his/her
device's image quality, and tells, for example, that the images are not sharp, it is fairly difficult to accurately
test the device and get an exact figure which would tell whether the device is functioning properly.

Often subjective evaluation has to be used for finding out if a certain property of the camera is acceptable
or not. Some training or experience of a correctly operating reference device may be needed in order to
detect what actually is wrong.

It is easy for the user to take bad images in bad conditions. Therefore the camera and the flash operation
have to be checked always in constant conditions (lighting, temperature) or by using a second, known-to-
be good device as reference.

When checking for possible errors in camera functionality, knowing what error is suspected significantly
helps the testing by narrowing down the amount of test cases.

Terms

Dynamic range Camera's ability to capture details in dark and bright areas of the scene
simultaneously.

Exposure time Camera modules use silicon sensor to collect light and for forming an
image. The imaging process roughly corresponds to traditional film
photography, in which exposure time means the time during which the
film is exposed to light coming through optics. Increasing the time will
allow for more light hitting the film and thus results in brighter image. The
operation principle is exactly the same with silicon sensor, but the shutter
functionality is handled electronically i.e. there is no mechanical moving
parts like in film cameras.

Noise Variation of response between pixels with same level of input illumination.

Resolution Usually the amount of pixels in the camera sensor. In some occasions the
term resolution is used for describing the sharpness of the images.

Sensitivity Camera module's sensitivity to light. In equivalent illumination conditions,
a less sensitive camera needs a longer exposure time to gather enough
light in forming a good image. Analogous to ISO speed in photographic
film.

Sharpness Good quality images are 'sharp' or 'crisp', meaning that image details are
well visible in the picture. However, certain issues, such as non-idealities
in optics, cause image blurring, making objects in picture to appear 'soft'.
Each camera type typically has its own level of performance.
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The effect of image taking conditions on image quality
There are some factors, which may cause poor image quality, if not taken into account by the end user when
shooting images, and thus may result in complaints. The items listed are normal to camera and Xenon flash
operation and are not a reason for changing the camera or Xenon flash modules.

Distance to target (too close)
The Xenon module may overexpose the image if the object is too close to the camera. The flash feedback
system may not work, if the distance to the object is closer than 20cm.

Figure 34 Overexposed image

Distance to the target (too far away)
The power of Xenon flash is limited and if the target is too far, it cannot be illuminated correctly. The
maximum distance for the acceptable image quality is roughly 2m. If the distance is greater than 2m the
images may start to be to dark and the noise level increases. This is normal behavior; do not change the flash
module.

Figure 35 Dark and noisy image
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Examples of good quality images

Figure 36 Good image taken indoors

Figure 37 Good image taken outdoors
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Xenon flash construction

For RM-313, Tabasco 1 module (4860024) is used. The feedback sensor is not used, only 1 capacitor.

The Xenon flash module as a component is not a repairable part i.e. components / parts in the module cannot
be changed. Cleaning dust from the lens is the only allowable operation, do this by using clean compressed
air.

The main parts of the module are:

• Molded lamp unit

• Fresnell lens area

• Xenon tube

• Auto focus LED

• Board-to-board connector to connect module to main pwb of device

• Signal flex

• Capacitor bank (with different amount / size capacitors)

• Ink marked serial number

Tabasco Xenon flash fixed to the phone mechanics e.g. with special clips and double side tape. The contacts
to the main PWB are formed by using B-to-B connectors (Hirose DF23C-10DP-0.5V - Nokia code 5409207).

List of risks
The Xenon module includes electrolytic capacitor(s) charged to voltage of 320V. Energy stored in the capacitor
(s) is 1.0…1.5J immediately after charging. If exposed to an electric shock it will most likely feel very nasty
on fingers. Possible risks causing an electric shock in a xenon module are:

• Broken flex between capacitors and lamp unit. The damage may be not visual.

• Broken molding on the lamp unit or capacitors.

• Cover window broken and xenon lamp exposed to the user.
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Figure 38 Possible sources of electric shocks

Handling instructions
With an undamaged module there is no possibility of an electric shock. However, the possible damage cannot
always be seen and therefore insulating glows should be always worn, when handling the Xenon module.

Disassembling the module is never allowed, because there is no way to fully discharge the module and also
repairing is impossible.

Care must be taken, when module is removed from the phone, because the flex is quite sensitive and can be
broken during removing. The flex should also not be bended or twisted unnecessarily.

Image quality analyses

Possible faults in image quality
When checking for possible errors in the flash functionality, knowing what error is suspected will significantly
help the testing by narrowing down the amount of test cases. The following types of image quality problems
may be expected to appear:

• Xenon module is not flashing at all

• Colours of the images are bad

• Flash power is weak (long distances, over 2m)

• Images overexposed at short distances (less than 20cm)

Testing module functionality
For testing module overall functionality, take an image with the flash and monitor same time whether the
LED flashes or not.

To do this test use always FORCED FLASH mode in the phone, not AUTOMATIC mode.

FORCED FLASH mode forces the LED module to flash even if there is some ambient light in present.

Testing image colors with the flash
For testing image colors with the flash. Take an image of the target, which contains something white. You
should take the image in the total darkness and from the ~ 1m range.

If the white target appears to be white then the flash is working correctly. However remember that there is
some variation in the flash color from module to module (see previous figure).
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Testing Flash power
For testing flash power, take an image with the flash in total darkness (ambient light level < 1 lux) from the
target about 80cm – 1m away from you.

If the flash is working normally with adequate power level the image is correctly exposed from 80cm – 1m
distances. Remember that the brightness level in the corners is always less than in the center of the image,
due to camera and flash optics.

Flash is not aligned correctly

Figure 39 Flash not aligned correctly
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Flash aligned correctly

Figure 40 Flash aligned corrctly

Image overexposed at ~0.5m distance

Figure 41 Overexposed image
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Troubleshooting Xenon flash
For testing flash overall functionality, take an image with the flash and monitor same time whether the
Xenon module flashes or not.

To do this test use always FORCED FLASH mode in the phone, not AUTOMATIC mode. FORCED FLASH mode forces
the Xenon module to flash even if there is some ambient light in present.

Assumption is that other components (UI.etc.) are working correctly and only flash & driver functionality are
troubleshooted.
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Bad image troubleshooting

Troubleshooting flow
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Indicator mode troubleshooting

Context
For checking the indicator mode functionality force camera to record a video clip and monitor the AF led at
the same time. LED should work with very low brightness constantly all the time the video is recorded.

Troubleshooting flow
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 Baseband description

System module block diagram
The device consists of two different main modules: transceiver and UI/slide module. Transceiver board
consists of baseband and RF components. UI/slide module consists of UI-FPC and keys.

Baseband functional description
Digital baseband consists of an ISA (Intelligent Software Architecture) based modem and symbian based
application sections. The modem functionality is in RAPIDOYawe, and the application processor acts as a
platform for Symbian applications.

The modem section consists of a RAPIDOYawe ASIC with combo memory (128Mbit NOR Flash + 128Mbit SDRAM)
as the core. RAPIDOYawe supports WCDMA/HSDPA and GSM protocols. RAPIDOYawe operates with the 38.4MHz
system clock, which comes from VCTCXO, and provides 19.2MHz system clock to application processor.

The application section includes an application processor ASIC OMAP2420 with combo memory (512Mb DDR
+ 2G NAND) as the core. Combo memory is soldered Package-On-Package (POP) on top of OMAP2420.

Absolute maximum ratings

Signal Min Nom Max Uni
t Notes

Battery voltage (idle) -0.3 +4.5 V Battery voltage maximum value is
specified during charging is active

Battery voltage (Call) +3.2 +4.3 V Battery voltage maximum value is
specified during charging is active

Charger input voltage -0.3 +20 V

Back-Up supply voltage 0 2.5 2.6 V Maximum capacity of the backup
power supply assumed to be 4 µAh.
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Phone modes of operation

Mode Description

NO_SUPPLY (Dead) mode means that the main battery is not present or its voltage is too low (below
EM ASIC N2200 master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low, but back-up battery voltage
is adequate and the 32kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over EM ASIC N2200
master threshold. All regulators are disabled, PurX is on low state, the RTC is on and
the oscillator is on. PWR_OFF (cold) is almost the same as PWR_OFF (warm), but the RTC
and the oscillator are off.

RESET RESET mode is a synonym for start-up sequence. In this mode certain regulators are
enabled and after they and RFClk have stabilized, the system reset (PurX) is released
and PWR_ON mode entered. RESET mode uses 32kHz clock to count the REST mode delay
(typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system
activity is low. There are in principle three different sleep modes:

• Application processor sleep

• RAPIDO sleep

• Application processor and RAPIDO sleep (deep sleep)

In sleep mode N2200’s regulators VIO, VDRAM, VSIM1 and VANA are in low quiescent
current mode (output voltages still present but regulators will not give as much current
out). VSIM2 is permanently off, and VAUX is always in the power on mode. Other
regulators including VR1 supplying system clock oscillator are disabled.

In SLEEP mode, N2390 VCore SMPS regulator is in low quiescent current mode.

In SLEEP mode, N2300 EM ASIC linear regulator VOUT state depends on the accessory
connected to the AV connector, if there is any.

FLASHING FLASHING mode is for SW downloading.

Voltage limits

Parameter Description Value

VMSTR Master reset threshold (N2200) 2.2V (typ.)

VMSTR+ Threshold for charging, rising (N2300) 2.1V (typ.)

VMSTR- Threshold for charging, falling (N2300) 1.9V (typ.)

VCOFF+ Hardware cutoff (rising) 2.9V (typ.)

VCOFF- Hardware cutoff (falling) 2.6V (typ.)

SWCOFF SW cutoff limit ~3.25V

The master reset threshold controls the internal reset of EM ASICs. If battery voltage is above VMSTR, N2300
charging control logic is alive. Also, RTC is active and supplied from the main battery. Above VMSTR, N2300
allows the system to be powered on although this may not succeed due to voltage drops during start up. SW
can also consider battery voltage too low for operation and power down the system.
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Power key
The system boots up, when power key is pressed (adequate battery voltage, VBAT, present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). Power key is connected to EM ASIC N2200 via PWRONX signal.
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Power distribution
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System power-up
After inserting the main battery, regulators started by HW are enabled. SW checks, if there is some reason to
keep the power on. If not, the system is set to power off state by watchdog. Power up can be caused by
following reasons:

• Power key is pressed

• Charger is connected

• RTC alarm occurs

• MBUS wakeup

CellMo engine (WG4.1M) is master during power up sequence i.e. CellMo side makes the decision when phone
is powered on. RSTX signal from AVilma is used to enable the startup sequence of Rel3.1 engine. The rising
edge of RSTX starts all the resources needed to boot RAPIDOYawe and OMAP2420 chips following the required
sequence:

1 When a valid wake up event happens (power key press, charger detection, RTC alarm or voltage detected
in MBUS line), AVILMA asserts RSTX signal high. RSTX enables the internal regulators of AVilma (VIO, VANA,
VDRAM and VR1), Betty, Menelaus1 and the discrete SMPS for RAPIDOYawe core. VIO enables the AVilma’s
internal 32kHz output buffer and VR1 starts the 38.4MHz VCTCXO on RF. Both 32kHz sleep clock and
38.4MHz RF clock start to run and are available in the system.

2 It takes max 0.65ms before Menelaus1 is ready to start the power-up sequence on the APE side. VIO_APE
starts first. It supplies power for APE side memories and OMAP2420POP I/Os.

3 SysClkReq signal has an internal pull-up resistor to IO voltage (VIO_APE) of OMAP, so it follows the slope
of VIO_APE. RAPIDOYawe activates the 19.2MHz system clock when it interprets SysClkReq as a logical 1.
This happens when SysClkReq reaches about 1V level.

4 When VIO_APE has completed its power-up, it is possible to apply signals to OMAP I/Os. 32 kHz sleep clock
is applied to OMAP.

5 When VIO_APE has completed its power-on sequence, the VCORE_APE is enabled and starts its ramp up
sequence.

6 When VCORE_APE ramp up is complete, VPLL_APE starts ramping up.

7 When VPLL_APE has ramped up, the PWROK signal is asserted to signal that the OMAP2420 power-up
sequence has been completed.

8 After a 16ms (typ) delay, the PURX signal is asserted high by AVILMA. Both CellMo and APE processors are
released out of reset with this signal. SW can start the controlling of SW controllable regulators on the
CellMo side.

9 OMAP2420POP completes its power-on sequence, and asserts nRESWARM high (after ~5x32kHz clock
cycles) when it is completed.

10 SW can start the controlling of VMMC_APE, VAUX_APE, VADAC_APE, VDCDC3_APE, V18_APE and V28_APE
regulators of M1 via the I2C interface.

Clocking scheme
There are two main clocks in the system:

• 38.4MHz RF clock produced by VCTCXO in RF section

• 32.768kHz sleep clock produced by the EM ASIC N2200 with an external crystal.

RF clock is generated only when VCTCXO is powered on by the EM ASIC regulator. The regulator itself is
activated by SleepX signal from RAPIDO. When both CPU’s are on sleep, RF clock is stopped.

RF clock is used by RAPIDOYawe, which provides 19.2MHz SysClk to the application processor. Both RAPIDO
and OMAP2420 have internal PLL’s that create clock signals for other peripheral devices/interfaces like SD
card, SIM, CCP, I2C and memories.
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BT and WLAN have their own 38.4MHz crystal oscillator that generates clock signal when clock request from
either WLAN or BT is high.

32k Sleep Clock is always powered on after startup. Sleep clock is used by RAPIDO and the application
processor for low power operation. Sleep clock is also used by GPS, FM Radio, Bluetooth and WLAN.
RAPIDOYawe and GPS the sleep clock is not buffered, for other modules the sleep clock is buffered (VIO_APE
is the buffer power supply).

SMPS Clk is a 2.4MHz clock line from RAPIDO to EM ASIC N2300 and discrete SMPS N2390. In deep sleep, when
VCTCXO is off, this signal is set to ‘0’ state.

9.6MHz Camera Clock is generated by Golden Eye.

Figure 42 Clocking diagram

Bluetooth and FM radio

Bluetooth
Bluetooth provides a fully digital link for communication between a master unit and one or more slave units.
Data and control interface for a low power RF module is provided. This device supports Bluetooth 2.0 +EDR
standard.
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The Bluetooth module (D6000) is a single chip solution that uses common clock signal (38.4 MHz) with WLAN
module. BT has interfaces to modem ASIC D2800 (PCM for BT audio), application ASIC D4800 (UART for BT
data) and to WLAN, which controls antenna usage.

FM radio
The FM radio is and integrated circuit, controlled by MCU software through a serial bus interface. The wires
of the headset are used as poles of the antenna, and no other antenna is needed for FM radio reception. The
FM radio utilizes the AV connector for its antenna connectivity. The RF input of the FM radio module is
connected to the stereo audio output pins (HS_EAR_L/R) via RF coupling circuitry. Wired headset connected
to the AV connector works as an antenna for FM radio. The FM radio is controlled by I2C commands from
RAPIDO. The audio output of the FM radio (D6000) is fed to the headset via EM ASIC N2200.
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Bluetooth and FM radio block diagram

Figure 43 Bluetooth and FM radio block diagram

WLAN
WLAN engine is divided into STLC4550 WLAN transceiver module and radio front-end module (FEM) RF5924.

STMicroelectronics Phaser STLC4550 is a three-die multichip module, partitioned to radio, baseband and
energy management die. STLC4550 is packaged to 8.5 mm x 8.0 mm x 1.4 mm 240-ball 0.5 mm pitch LFBGA.
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STLC4550 implements 802.11b/g WLAN radio for embedded, low-power and small form factor mobile
applications. STLC4550 conforms to the IEEE 802.11b/g protocols operating in 2.4 GHz band supporting OFDM
data rates of 54, 48, 36, 24, 18, 12, 9, and 6 Mbps as well as CCK data rates of 11 and 5.5 Mbps and legacy
data rates of 2 and 1 Mbps. IEEE802.11e/i protocol extensions are included to implement quality of service
(QoS) and security functions.

STLC4550 has a fully integrated radio chip including a direct-conversion transceiver, RF synthesizer and VCO,
and high-speed data converters. Digital interface is used for transferring the sampled data between radio
and baseband chip. The baseband chip implements OFDM/CCK digital baseband processor and ARM9- based
MAC with internal SRAM memories. The baseband includes required logic and interfaces to enable time-shared
simultaneous use of BT and WLAN.

The energy management unit integrates required power management functions to operate the system from
VBAT (3.0 – 5.5 V). The EM unit generates 1.2 V digital core voltage, two 1.8 V supplies for RF and 2.8 V LDO
for PA bias supply. The EM unit also integrates power-on reset circuitry and level-shifters for RF front-end
GaAs switches.

Host interface is provided by a flexible serial interface (SPI) supporting clock frequency upto 48 MHz. The
maximum usable SPI clock rate depends on the host side clocking options and timing requirements. Typically
rates of 14 – 24 MHz are achieved. WLAN/BT coexistence interface enables automatic time shared usage of
WLAN and Bluetooth.

The system uses 38.4 MHz reference clock. In this device dedicated oscillator circuit for WLAN and Bluetooth
reference clock is used. Low power sleep mode operation is enabled using 32768Hz low speed clock and
energy management stand-by state.

WLAN RFMD RF5924 front end module is used. Power amplifier, RF-switches and baluns are integrated to
FEM. The PA includes power detector for closed-loop power control purposes. WLAN/BT bandpass filter is
external ceramic filter.
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Table 12 General WLAN specifications

Supported channels USA 1-11 (2412-2462MHz)

ETSI 1-13 (2412-2472MHz)

Transmitter power

Barker/CCK (1, 2, 5.5, 11Mbps datarate)

OFDM-BPSK(6, 9 Mb/s)

OFDM-QPSK(12,18 Mb/s)

OFDM-16QAM (24, 36 Mb/s)

OFDM-64QAM (48,54 Mb/s)

17dBm

15dBm

15dBm

13dbm

13dBm

Power control range 0-17dBm

Receiver sensitivity (typical)

11M/bits. 1024bytes / 8% PER

54 Mb/s, 1000 bytes, 10% PER

-83dBm

-70dBm

GPS interface
The device includes an inbuilt GPS receiver and it works as a stand-alone positioning device. The antenna is
located below the main keypad in the bottom of the product.
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The GPS system is connected to RAPIDO ASIC.

Figure 44 Block diagram of the GPS system

USB
The device supports USB 2.0 full speed, with micro-USB connector.

USB connection is implemented using the Application ASIC D4800 USB controller interface and N2300 EM
ASIC’s USB transceiver. External interface is the micro-B connector. The interface between N2300 transceiver
and micro-B receptacle is standard USB interface specified Universal Serial Bus specification Rev. 2.0. The USB
transfers signal and power over four-wire interface. Interface carries differential data, Vbus and GND.
Signalling occurs over differential data line, D+ and D-. The clock is transmitted, encoded along with the
differential data. ESD protection is done with USB ASIP. VBUS (+5V) is provided by the host device.
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SIM interface
The SIM (Subscriber Identification Module) interface is located in two ASICs; Cellular Modem ASIC D2800
contains most of the interface functionality and the mixed signal ASIC N2200 takes care of power up/down,
card detect, ATR counting and level shifting. ESD protection components are integrated to N2200 ASIP.

Figure 45 SIM interface

SD card interface
Memory card interface is compliant with the MultiMediaCard Specification version 4.x, the SD Memory Card
Specification, Physical Layer Specification version 2.00 and Secure Digital Input/Output Card Specification,
Version 1.20.

The host in the SD card interface is application ASIC D4800. SD card transceiver/level shifter is in application
side mixed signal IC (N4200). There are four data signals, one command signal and a clock output signal
going in N4200. For transceiver control, there are direction signals to each data signals and one also for CMD.
A feedback clock is coming from transceiver to host. Memory card transceiver is controlled by D4800 I2C_APE.

Clock frequency used is 24MHz. ESD protection is implemented with an ESD ASIP, Z5200.
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Hot-Swap
To enable Hot-Swap of the micro SD card, the device uses an SD card connector with a pre-warning signal.
To enable card removal, the user needs to push SD-card further in to the connector first. This gives so-called
pre-warning signal to the system and ongoing write/read operation can be finished safely before card is
removed. Note that this is just a backup mechanism and does not cover all the use cases (writing/reading
large amount of data): the user should always close the SD-card before starting the card removal.

Figure 46 Pre-warning principle

TV-out interface
A TV-out connection is implemented using the application processor (D4800) Video DAC interface and an
external analogue line driver (N5650). The device engine supports the following systems using composite
video (CVBS):

• M/NTSC

• J/NTSC

• 4.43/NTSC

• M/PAL

• N/PAL

• Nc/PAL

• B/PAL

• G/PAL

• D/PAL

• H/PAL

• I/PAL

CVBS is a single video signal containing all the necessary information to reproduce a colour picture. The video
signal is filtered with ASIP R5650, and connected to AV-connector pin 3. Switch N2002 is used to connect AV
connector pin 3 to TV-out, the same pin is used also as a microphone line.
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Battery interface
The device uses BP-6MT Battery with TABBY interface. There are two manufacturers for BP-6MT Batteries and
they have different discharge curves; SW recognizes battery manufacturer from BSI resistor value (27k or
82k).

Charging
Charging is controlled by different blocks depending on the situation: If battery is totally empty, the charging
is controlled by CHACON block in N2300 and the battery is first charged with constant current until the voltage
rises above certain limit (VMSTR+). Then the digital part of N2300 takes care of the charging and PWM charging
is done until PURX is released. After this SW starts to control the charging.

The device has Li-Ion battery, which has protection circuit that limits the lowest battery voltage to 2.8V, and
constant current mode is practically never used.

Camera interfaces

Camera system
The device's camera system consists of camera processor, which is connected to the application processor.
The camera processor has external SDRAM and it used N5452 IC to control AF and mechanical shutter. The
main camera and flash driver is connected to the camera processor. The front camera (second camera) is
connected to application processor and it shares the CCP-bus with the camera processor through switches
N5400 and 5401.

Figure 47 Camera system block diagram

Main camera characteristics

Sensor type CMOS

Sensor photo detectors 5.0 million (2592 x 1944 pixels)

F number/Aperture f/2.8
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Focal length 5.6/35 mm (35 mm equal)

Focus range 10 cm to infinity

Still Image resolutions up to 5 Megapixel: 2592x1944

Still images file format EXIF (JPEG), *.jpg

Video resolutions VGA 640 x 480 at 30 fps/15 fps

320 x 240 (QVGA) at 30/15 fps

176 x 144 at 15 fps (QCIF)

Video clip length Maximal clip length is 60 mins (High or Normal quality)
or limited to MMS size approx. 30 seconds (Sharing
quality)

Note: Clip length is dependable on available
memory

Video file format .mp4 (default) and .3gp (for MMS)

Auto exposure Center weighted AE

White balance Automatic, sunny, cloudy, incandescent, flurescent

Colour tones Normal, sepia, vivid, black&white, negative

Capture Modes Still capture mode, video mode and sequence mode

Selftimer 2, 10, or 20 secs

Flash settings Auto, off, forced, anti red-eye

Automatic image rotation On / Off

Camera flash
The device has also camera xenon flash located directly beside the main camera, providing better image
quality in darker environments. The xenon flash has also build in Amber AF/indicator LED that is used as a AF
(Auto Focus) assistant light and a privacy indicator. The Amber led is lit during video recording and it is also
used to indicate image capture with main camera.

The xenon flash is located on flex and the flex is connected to main PWB through connector. The camera flash
has one xenon tube and one Amber LED inside the module. The module also includes a lens with its plastic
housing to ensure a proper AF assistance at the target.

Secondary camera characteristics

Sensor type CMOS

Sensor Photo detectors CIF

F number/Aperture f/2.8

Focal length 43 mm (35mm equivalent)

Focus range 10 cm to infinity

Still Image resolutions QVGA

Still images file format JPEG/EXIF
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Accelerometer
The device has an accelerometer, which is used in automatic image rotation. Accelerometer is connected to
application processor through I2C bus. Image rotation has build-in hysteresis.

Audio concept

Audio HW architecture
The functional core of the audio hardware is built around two ASIC’s: Cellular Modem ASIC D2800 and the
mixed signal EM ASIC N2200.

There are four audio transducers:

• Dynamic earpiece (part of UI/Slide module)

• 2 Dynamic speakers

• Electret microphone

In addition to the audio transducers, N2200 also provides an output for the dynamic Vibra component. All
galvanic audio accessories are connected to the AV-connector. Bluetooth audio module, that is connected to
Cellular Modem ASIC D2800 supports Bluetooth audio functionality. For some audio applications, part of the
processing is done on application processor ASIC D4800, for example for Music Player.
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Figure 48 Audio block diagram

Internal microphone
The internal microphone is used for HandPortable (HP) and Internal HandsFree (IHF) call modes. Also if the
accessory headset does not have microphone, the phone uses the internal microphone. An analogue electret
microphone is connected to the EM ASIC N2200 Mic1P input via asymmetric electrical connection. The
microphone is biased by the EM ASIC MicB1 bias voltage output.

External microphone
Galvanic accessories are connected to the 3.5mm AV-connector. Accessory audio mode is automatically
enabled/disabled during connection/disconnection of dedicated phone accessories. External microphone is
connected to EM ASIC N2200 input Mic2P and Mic2N. Mic2P, Head_Det line of EM ASIC N2200 and Composite
Video input from application ASIC are multiplexed to the same AV-connector line.
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Internal earpiece
The internal earpiece is used in the HandPortable call mode. A dynamic earpiece capsule is connected to the
EM ASIC N2200 differential outputs EarP and EarN. Internal earpiece is placed on UI / Slide Module.

Figure 49 Internal earpiece schematics

Internal speaker
The internal speakers are used in Internal HandsFree (IHF) call mode and for ringing tones. They can also be
used for example with GPS navigation instructions or with Music Player. Two dynamic speakers are connected
to the N2120 stereo amplifier. Signal to the amplifier comes from N2200 outputs XearL and XearR.

Figure 50 Stereo IHF connection

External earpiece
All galvanic accessories are connected to the AV-connector. Any accessory with 3.5mm plug can be used.
Accessory detection mechanism is described in separate chapter. Stereo signal to external earpiece comes
from N2200 outputs XearL and XearR. Attenuation is needed before headphone amplifier in the use case
where ringing tone is played from IHF speakers and earpiece simultaneously.
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AV connector
The device has a 3.5mm AV-connector. The user can use it to connect any audio accessory or e.g. TV-out cable
to the phone. In-box headset (HS-43) is so-called Enhancement Control Interface (ECI) accessory. If the
connected cable is not ECI accessory, cable recognizing is based on impedance on the microphone line. If the
cable cannot be recognized, the user can select which accessory type is connected to the phone.

There are five Audio Control lines from Cellular Modem ASIC D2800 to control control audio and AV-connector
related electronics. Those signals and default stages of the signals are described in the following table.

Table 13 AUDIOCTRL interface

Signal Control Default state / action

AUDIOCTRL(0),
AVPaEn

Headphone amplifier 0 (shutdown)

AUDIOCTRL(1),
AVPlugDet

Plug_det from AV-
connector

1.8V (VIO), grounded when 3.5mm plug
inserted

AUDIOCTRL(2),
AVECICtrl

Mic2P / head_det
switch N2001

Default 0 (microphone line connected
to Mic2P). When 1, microphone line
connected to head_det -> ECI-detection

AUDIOCTRL(3),
AVVideoCtrl

Mic2P / Comp_Video
switch N2002

Default 0, (microphone line connected
to Mic2P). When 1, Composite Video
from APE connected to microphone
line.

AUDIOCTRL(4),
IHF_AMP_EN

Attenuation switches
N2030 and N2031, IHF
amp N2120

Default 0, IHF amplifier and
attenuation not used.

Figure 51 AV connector component layout and pads

Figure 52 Connector pin layout (Plug conductors from left to right HS EAR L, HS EAR R, HS MIC/Cntrl. and HS GND)
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Table 14 Pin configuration

3.5mm Signal name Direction Description

Pin #

6 PLUGDET In Terminal internal connection, plug
detection

5 HS EAR L In / Out Audio output

4 HS EAR R In / Out Audio output,

3 HS MIC In / Out Multiplexed microphone audio and
control data, C-video out

1, 2 HS GND - Ground contacts

There are three different use cases for AV connection. In all cases the PLUG_DET is used for detecting plug
insertion and removal. EAR lines are used for FM antenna reception.

• Headset or similar with ECI or without ECI.

When a headset is detected the terminal will check if there is ECI circuit in the accessory. If the ECI chip is
present, tuning values for that is taken into use otherwise basic audio tuning parameters are used.

• Headphones

For the headphones and any 3-pole connector devices, the headphones option is used.

Note: The mic line and the ground line are connected together.

• Video out

For example, when connecting terminal to television all pins are used.

Note: The microphone is multiplexed to C-video. The cable has to be inserted first to television set
and then to the terminal, otherwise the automatic detection does not work according to the
specification.

User interface

Display

Display features
• Module size (width x height x thickness) 41.78 mm x 58.37 mm x 2.1 mm

• Resolution QVGA (240*320)

• Numbers of colours up to 16.7M

• Partial display function; power saving by pausing display process on part of the screen

• Built-in RAM capacity 240 columns x 320 rows x 24 bits RAM

• Transflective optics

The display has two different operating modes:

• Normal mode, Full screen, 16.7 million colors

• Partial idle mode, 8 colors but only part of the display is active

Display is located on front side of phone. The interconnection between the LCD module and Engine is done
with a 24-pin B2B-connector.

The display is controlled via MeSSi-8 interface with an 8-bit bus by the application processor. All MeSSi signals
go through the EMC filtering ASIPs (Z4405 and Z4406). The display module does not require any tunings in
service.
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Display and keyboard backlight
The device uses SMPS Led Driver to drive display and S60 keyboard LED’s. Three display backlight LED’s are
connected in series (located in display module). Three S60 LEDs are also connected in series, parallel to display
LED branch via current mirror. Current feedback is done with display LED current. SMPS (N1151) and related
discrete components are located on system/ RF module. Current mirror and S60 LED’s are placed on UI-FPC.
Display LED brightness can be controlled with PWM signal (0-100%, ~293Hz). S60 LEDs can be turned OFF
separately.

ITU keyboard and Side Keys are illuminated with LED’s that are driven with charge pump N1150. ITU keys can
be turned on as one group. Side keys will always be turned ON and OFF as a light sequence. Brightness of
charge pump driven LED’s cannot be controlled

Figure 53 ITU/S60 display circuitry
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Figure 54 Side key illumination circuitry

Ambient Light Sensor
Ambient Light Sensor is located in the UI/Slide module, in the upper part of the phone. It consists of the
following components:

• Lightguide (part of UI/Slide module cover).

• Ambient Light Sensor (ALS). ALS is logarithmic, which response to light is similar to human eye. ALS is
located on UI-FPC and it is not a spare part.

• Analog switch N4400, to turn on operating voltage VAUX to ALS only when needed.

• Pull-down resistor R4400 to convert current signal to voltage.

Ambient Light Sensor information is used to control backlights of the phone. Keyboard backlight is turned
OFF, when they are not needed. Display backlight is dimmed, when environment lighting is dark. Outdoors,
when environment is bright, display backlight is turned off. Ambient Light Sensor is calibrated in production.
In service points, calibration is not possible.

Keyboard
The device has two separate keyboards:

• S60 keyboard

• ITU keyboard

The S60 keyboard is assembled on the UI/slide module. If there’s failure on this part, the whole module has
to be replaced. ITU keyboard pads are placed directly on the system/RF module.

ITU keyboard is visible, when display is moved upwards. Keypads are on the system/RF module. System/RF
module includes also side keys (Volume Keys, Imaging Key and 2-position camera key)
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Col0(Gpio117) Col1 (Gpio94) Col2(Gpio115) Col3 (Gpio96) Col4 (Gpio95)

Row0
(Gpio28)

LeftSK RightSK NaviLEFT NaviRIGHT Not used

Row1
(Gpio23)

SEND NaviSELECT NaviUP NaviDOWN Zoom/Vol Up

Row2
(Gpio69)

7 2 End Not used #

Row3
(Gpio70)

5 Capture Full Not used Not used 4

Row4
(Gpio27)

9 * Review Not used 3

Row5
(Gpio68)

1 Capture Half Multimedia Not used 6

Row6
(Gpio58)

0 8 Clear Application Zoom/Vol Down

• Col 0-4 and Row 0-4 are filtered with ASIP Z4405.

• Row 5 and Row 6 are filtered with ASIP Z4406.

Power key is also placed on the system/RF module. It connected directly to EM ASIC N2200 PWRONX PIN.

Slide position sensors and camera cover switch
MR Sensor is used to detect camera cover open/ close position. MR Sensor is located on a separate PWB
(daughter PWB) which is located inside the B-Cover. Magnet is located inside the camera door cover. MR
Sensor is connected to the application processor ASIC (D4800) GPIO’s. Sliding the camera door cover will
enable main camera and vice versa.

Figure 55 Camera cover block diagram
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 RF description

Block diagram

Figure 56 RF block diagram RM-313 using RF ASIC N7505

The RF block diagram for RM-313 uses RF ASIC N7505 that performs the RF back-end functions of receive and
transmit function of the cellular transceiver.

Receiver (RX)
An analogue signal is received by the phone's antenna. The signal is converted to a digital signal and is then
transferred further to the baseband (eg. to the earpiece).

The receiver functions are implemented in the RF ASIC.

Signals with different frequencies take different paths, therefore being handled by different components.
The principle of GSM and WCDMA is the same.

RM-313
System Module

Page 6 –28 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



Transmitter (TX)
The digital baseband signal (eg. from the microphone) is converted to an analogue signal, which is then
amplified and transmitted from the antenna. The frequency of this signal can be tuned to match the bandwith
of the system in use (eg. GSM900).

The transmitter functions are implemented in the RF ASIC.

Even though the GSM and WCDMA signals are sent via different components, the principles of the transmission
is the same.
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 Frequency mappings

GSM850 frequencies
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EGSM900 frequencies
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GSM1800 frequencies
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GSM1900 frequencies
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WCDMA 2100 Rx frequencies
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WCDMA 2100 Tx frequencies
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A/D-converter Analogue-to-digital converter

ACI Accessory Control Interface

ADC Analogue-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic (type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2, UEME and Zocus

CCP Compact Camera Port

CDMA Code division multiple access

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSD Circuit-switched data

CSR Cambridge silicon radio

CSTN Colour Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analogue converter

DAC Digital-to-analogue converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

DCT-4 Digital Core Technology
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DMA Direct memory access

DP Data Package

DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DTM Dual Transfer Mode

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evolution

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compatibility

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HSDPA High-speed downlink packet access

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

IrDA Infrared Data Association
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ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out

LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

MTP Multipoint-to-point connection

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architecture

OMAP Operations, maintenance, and administration part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RF PopPort™ Reduced function PopPort™ interface

RFBUS Serial control Bus For RF
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RSK Right Soft Key

RS-MMC Reduced size Multimedia Card

RSS Web content Syndication Format

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)

RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noise ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCP/IP Transmission control protocol/Internet protocol

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPnP Universal Plug and Play

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator
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Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WCDMA Wideband code division multiple access

WD Watchdog

WLAN Wireless local area network

XHTML Extensible hypertext markup language

Zocus Current sensor (used to monitor the current flow to and from the battery)
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